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Sažetak 

 

Između S}nice i Prizne (dionica državne ceste D8) učestalo dolazi do zatvaranja prometa usljed 
jakih udara vjetra (bure) za prvu skupinu vozila (autobusi na kat, vozila s kamp-prikolicom i 
motocikli). Zatvaranje ceste između S}nice i Prizne dešava se kada izmjereni sekundni udari 
vjetra na Balinskom vijaduktu premaše 25 m/s u slučaju mokrog kolnika i 30,6 m/s u slučaju 
suhog kolnika (prema važećem pravilniku Hrvatskih cesta).  

 

U ovom radu provedena je analiza prostorne raspodjele brzine vjetra na dionici ceste između 
S}nice i Prizne temeljem modula „Wind e昀昀ect“, dostupnog u sklopu plavorme QGIS, te brzine 
i smjera vjetra iz numeričkog atmosferskog modela Aladin-Hr u razdoblju 1998.-2001. U QGIS 
sučelju je za proračune brzine uzduž analizirane cestovne dionice korištena prostorna 
rezolucija podataka od 25m, a podaci o brzini i smjeru vjetra iz modela Aladin-Hr imaju 
prostornu rezoluciju od 4km i vremensku rezoluciju od 3h.  

 

Rezulta} provedenenih proračuna pokazali su da nije potrebno proves} zatvaranje ceste D-8 
na dionici S}nica – Prizna ukoliko se na referentnoj anemografskoj postaji za cestu D-8 (Balinski 
most) registrira premašenje maksimalno dopuštenih brzina vjetra.    
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1. UVOD 

Situacije u kojima je promet zatvoren generiraju  neposredni i posredni društveni trošak kroz 
izgubljeno vrijeme, nemogućnost obavljanja poslova koji zah}jevaju prolazak tom dionicom, 
nega}van utjecaj na turizam i slično. Iz tog razloga potrebno je utvrdi} može li se kroz doradu 
protokola za zatvaranje prometnice na pojedinim dijelovima prometnice smanji} ukupno 
vrijeme u godini u kojem je prometnica zatvorena. 

 

Protokol zatvaranja državne ceste D-8 za cijelokupnu dionicu od S}nice do Prizne je sljedeći. 
Dežurni službenik u društvu kapitala (privatne 昀椀rme) pra} prognoze o brzini i smjeru vjetra 
(model Aladin-Hr za prognozu vjetra +72h). Ukoliko prognoza ukazuje na moguću pojavu vrlo 
jakog i olujnog vjetra (primarno bure) prate se mjereni jednosekundni udari vjetra na 
lokacijama Balinski vijadukt (meteo postaja od HC, pra} se i temperatura i stanje kolnika, 24km 
od Senja). Prema potrebi na teren se šalje ophodar koji s ručnim anemometrom mjeri udare 
vjetra.  

 

Prema tablici iz Pravilnika o obavljanja prometa u zimskim uvje琀椀ma donosi se odluka o 
zatvaranju ceste. Primjerice, za autobuse, teretna i osobna vozila maksimalni dozvoljeni 
sekundni udari vjetra su 110 km/h pri uvje}ma suhog kolnika, 90 km/h pri uvje}ma mokrog 
kolnika, te 60 km/h pri uvje}ma zaleđenog kolnika. 
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2. PODLOGE – BRZINE I SMJER VJETRA IZ MODELA ALADIN - HR 

 

U Državnom hidrometeorološkom zavodu Hrvatske je trenutno opera}vno funkcionalan 
atmosferski model Aladin-Hr u hidrostatskoj verziji baziranoj na primi}vnim jednadžbama sa 
numeričkom implementacijom razvijenom u kooperaciji sa nekoliko nacionalnih meteoroloških 
ins}tucija. Model proizlazi iz globalnog ARPEGE (Ac}on de Recherche Pe}te Echelle Grande 
Echelle) modela od Meteo-France (Cour}er i sur., 1991.), sa kojime izmjenjuje i podatke o 
većini 昀椀zikalnih relevantnih parametara potrebnih za de昀椀niranje rubnih uvjeta (Cordoneanu i 
Geleyn, 1998.). Model Aladin koris} prostornu rezoluciju dostatnu za razlučivanje intenzivnih 
izmjena u smjerovima i intenzite}ma prevladavajućih vjetrova na području Jadrana (Brzović i 
Strelec-Mahović, 1999.; Ivatek-Sahdan i Tudor, 2004.). 

 

Na slici 2.1 prikazane su  točke ekstrakcije rezultata brzine i smjera vjetra iz numeričkog 
atmosferskog modela Aladin-HR sa prostornom rezolucijom 4km i vremenskom rezolucijom 
rezultata od 3 sata (za razdoblje 1998.-2001.). Točka 1 predstavlja poziciju proračunske ćelije 
numeričkog modela Aladin-Hr u kojoj se nalazi i Balinski vijadukt.   

 

 

Na slikama 2.2 i 2.3 prikazane su vremenske serije brzine i smjera vjetra prema rezulta}ma 
numeričkog atmosferskog modela Aladin-Hr za razdoblje 1.1.1998.-1.1.2002. (4 km prostorna 
rezolucija i 3 satna vremenska rezolucija podataka) za poziciju točke 1 (Balinski most).  
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Slika 2.1 Ćelije iz proračunske mreže atmosferskog modela Aladin-Hr (prostorna rezolucija 4km) na 
dionici državne ceste D-8 od Novog Vinodolskog do Karlobaga (u ćeliji 1 nalazi se Balinski vijadukt)  
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Slika 2.2 Vremenske serije brzine vjetra prema rezulta琀椀ma numeričkog atmosferskog modela Aladin-
Hr za razdoblje 1.1.1998.-1.1.2002. (4 km prostorna rezolucija i 3 satna vremenska rezolucija 
podataka), za poziciju točake 1 (Balinski vijadukt) 

 

 

 

 

 

Slika 2.3 Vremenska serija smjera vjetra prema rezulta琀椀ma numeričkog atmosferskog modela Aladin-
Hr za razdoblje 1.1.1998.-1.1.2002. (4 km prostorna rezolucija i 3 satna vremenska rezolucija 
podataka), za poziciju točke 1 (Balinski vijadukt) 
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Potrebno je napomenu} da su izlazni podaci iz modela Aldin-HR trosatni srednjaci brzine i 
smjera vjetra (slika 2.2), a udari vjetra su jednosekundne vrijednos}. Iz prikazanog dijagrama 
sa slike 2.4 mogu se očita} koe昀椀cijen} uvećanja, sa trosatnog u jednosatnu vrijednost Vsatni = 
1/0,93* Vtrosatni, te nakon toga iz jednosatnog u sekundni Vsekundni = 1,55* Vsatni.  

 

Nadalje, podaci iz modela Aladin-Hr odnose se na visinu 10 m iznad terena, a što za potrebe 
daljnjih proračuna treba sves} na razinu na kojoj se kreću vozila (usvojeno 2m iznad terena). 
Može se koris}} empirička jednadžba raspodjele brzine u površinskom graničnom sloju (V2m = 
V10*(2/10)0,2 ; V2 - brzina vjetra na visini 2m nad terenom za more; V10 - brzina vjetra na 10m 
nad terenom iz modela Aladin-HR). Prema tome, brzina sekundanog udara vjetra od 25 m/s 
odgovara trosatnoj brzini vjetra od 19 m/s. Stoga se iz cjelokupnog seta podataka za 
korelacijske odnose koriste samo oni podaci u kojima trosatna brzina vjetra iz modela Aladin-
HR premašuje vrijednost 19 m/s.    

 

 

Slika 2.4 Faktor mahovitos琀椀 vjetra CG
3600(zm,t) za t-sekundni udar na visini zm = 10 m kad je poznata 

srednja satna brzina vjetra   )z(U ms3600  na visini zm i faktor mahovitos琀椀 vjetra CG
600(zm,t) za t-

sekundni udar na visini zm = 10 m kad je poznata 10-minutna srednja brzina vjetra   )z(U ms600  na 

visini zm; sve za standardni teren na kopnu zo=0,05 m 

 

Iz izdvojenog skupa podataka (slika 2.3) može se zaključi} da se smjerovi vjetra na poziciji 
Balinskog vijadukta pri postavljenom uvjetu premašenja sekundnog udara vjetra od 25 m/s (19 
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m/s u slučaju trosatnog srednjaka) pojavljuju u rasponu od 180 do 290. Stoga se u kasnije 
korištenom modulu „Wind e昀昀ect<, u okviru QGIS sučelja, za cijelu prostornu domenu de昀椀nira 
homogeni smjer djelovanja vjetra sa smjerom 22,50 (NNE).  



Uspostava modela prostorne raspodjele vjetra u QGIS sučelju 
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3. USPOSTAVA MODELA PROSTORNE RASPODJELE VJETRA U QGIS SUČELJU 

U nastavku su prikazani koraci uspostave modela u QGIS sučelju temeljem kojeg se 
praračunava prostorna raspodjela brzine vjetra s prostorom rezolucijom podataka od 25m. 
Proračunom se dobivaju rela}vni odnosi brzina u odnosu na proizvoljno de昀椀niranu referentnu 
poziciju.  

3.1. Početne postavke sučelja i uvlačenje osnovnih podloga 

Postavljamo sloj HTRS umjesno difoltnog WGS 84 (EPSG: 4326). Lijevi klik na simbol globusa sa 
tekstom EPSG: 4326 u donjem desnom dijelu ekrana.   

 

 

Slika 3.1 Postavljanje novog referentnog koordinatnog sustava 

U novootvoreni prozor u prvo polje „Filter< upisa} HTRS, a iz dolje ponuđenog menija odabra} 
HTRS / Croa}a TM EPSG:3765 → OK. 
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Slika 3.2 Postavljanje HTRS96 / Croa}a TM EPSG 3765 referentnog koordinatnog sustava 

Za uvlačenje gra昀椀čke podloge „OpenStreetMaps< u gornjem lijevom prozoru „Browser< 
pozicionira} se na XYZ Tiles → OpenStreetMap → desni klik → Add Layer to project  

 

Slika 3.3 Uvlačenje „OpenStreetMaps< sloja (layera)  

Sada je taj sloj uvučen u donji lijevi prozor „Layers<. Zumiramo na područje RH. 



Rezulta琀椀 provedenih analiza 

 

Završni rad: Marta Paradžik 9 

 

 

Slika 3.4 Uvećavanje i postavljanje prozora na područje RH 

Uvlačenje novog sloja (layera), u ovom slučaju rastera sa geodetskim visinama terena u 
prostornoj rezoluciji 25m x 25m, obavlja se pri}skom na ikonu „Open data source Manager<, 
te izborom „Raster<. Nakon toga, pri}skom na gumb sa desne strane pored polja „Source< 
otvara se preglednik za dohvaćanje odgovarajuće datoteke. Odabiremo odgovarajuću datoteku 
„EU_DEM_RH_HTRS96.}昀昀<. Open→ Add → Close. 
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Slika 3.5 i Slika 3.6 Uvlačenje rasterskog sloja RH prostorne rezolucije 25m x 25m  

Nakon provedbe navedenog postupka pojavljuje se dodatni rasterski sloj. Ukoliko želimo da se 
prikazani raster pojavljuju u spektru potrebno je sljedeće: u prozoru „Layers< desni klik na 
rasterski sloj → Proper琀椀es  → Symbology. U polju „Render type< odabra} „Singleband 
pseudocolor<, u polju „Color ramp< odabra} Invert color ramp, Apply → OK. 
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Slika 3.7 i Slika 3.8 Dodavanje spektralnog izgleda rasteru  

Sada uvlačimo novi sloj (layer), u ovom slučaju vektorski linijski sloj sa kategoriziranim 
prometnicama u RH. Pri}snemo na ikonu „Open data source Manager<, te izborom „Vector<. 
Nakon toga, pri}skom na gumb sa desne strane pored polja „Source< otvara se preglednik za 
dohvaćanje odgovarajuće datoteke. Odabiremo odgovarajuću datoteku „Cestovni 
promet.shp<. Add → Close. 

 

Ponovno se može proves} već prethodno pokazni postupak za prezentaciju elemenata 
pojedinog sloja u različi}m bojama. Desni klik na vektorski sloj sa vodotocima u lijevom donjem 
prozoru „layers< → Proper琀椀es  → Symbology. U prvom polju biramo „Categorized< a u polju 
„Value< biramo „fclas< (klasa ceste). S}snemo na donji gumb „Classify<. Apply → OK. U prooru 
Layers iksljučimo kvačice za sve kategorije ceste osim željene. Za prometnicu D8 to je 
„primary<. 
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Slika 3.9 Rasterski visinski sloj cijele RH u spektralnom izgledu („DEM<) 

 

Slika 3.10 Uvlačenje vektorskog linijskog sloja „Cestovni promet< 

Sada je potrebno napravi}-kreira} vektorski poligonski sloj koji pokriva samo područje na 
kojem se nalazi dionica ceste D8 od S}nice do Prizne 

 

Layer → Create Layer → New shape 昀椀le layer 
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Nakon otvaranja kar}ce za de昀椀niranje novog vektorskog sloja, pri}skom  na gumb sa desne 
strane polja „File Name< odabiremo lokaciju pohrane datoteke vektorskog sloja i njegovo ime 
(npr. „Poligon_D8<). U polju „Geometry type< odabiremo „Polygon<, a u polju ispod geodetski 
CSR sloj (u našem slučaju HTRS / Croa}a TM). Polja „New Field< i „Field list< trenutno nam nisu 
interesantna. Kar}cu zatvaramo sa OK. Formiran je novi vektorski poligonski sloj 
„Poligon_D8.shp< (vidljiv sa lijeve strane u prozoru „Layers<). 

 

 

Slika 3.11 Klasi昀椀kacija vektorskog sloja „Cestovni promet< po klasama ceste 
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Slika 3.12 Kreiranje vektorskog poligonskog sloja 

Pri}snemo gumb „Toggle edi}ng< kako bi omogućili edi}ranje novo formiranog vektorskog 
sloja, te gumb „Add Polygon< kako bi ucrtali željeni poligon. Za bolju preglednost radnog 
prozora može se ukinu} vidljivost drugih prethodno napravljenih vektorskih ili rasterskih 
slojeva (micanje kvačice pored tog sloja u prozoru „Layers<).  

 

 

Slika 3.13 Prebacivanje na uređivanje poligona 
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Lijevim klikom miša i povlačenjem miša pažljivo se iscrtavaju konture poligona na način da se 
približno obilazi dionica ceste D8 od S}nice do Prizne . Na poziciji zadnje točke poligona 
dvostruki lijevi klik, a nakon čega se pojavljuje kar}ca „Poligon D8 – Feature A琀琀ributes<. 
Obzirom da mi nećemo dava} nikakve atributne vrijednos} nacrtanom poligonu samo OK.  

 

 

Slika 3.14 Iscrtavanje poligona oko tražene dionice ceste D8  

Ponovno s}snemo na ikonu olovke (gumb „Toggle edi}ng<) kako bi naznačili prekid edi}ranja 
poligona,  a nakon čega potvrđujemo da želimo pohranu unesenih promjena na poligonskom 
sloju. Ovaj poligonski sloj će nam posluži} da napravimo ekstrakciju prethodno unesene 
podloge (vektorski linijski sloj prometnica u RH „Cestovni promet<) samo na području 
primarnog interesa . 
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Slika 3.15 Spremanje poligona „poligon D8< potrebnog za kreiranje zadanog dijela dionice D8  

U nastavku želimo smanji} („klipa}<) područje prometnica u RH samo na područje koje je 
pokriveno prethodno napravljenim vektorskim poligonom „Poligon_D8<. To se provodi uz 
pomoć QGIS ru}ne „Clip<. 

Vector → Geoprocessing Tools → Clip 

 

Slika 3.16 Otvaranje alata „Clip< 

U polju „Input layer< odaberemo vektorski linijski sloj „Cestovni promet<, a u polju „Overlay 
layer< vektorski poligonski sloj „Poligon_D8<. Nakon toga s}snemo na gumb pored polja 
„Clipped<, te odaberemo „save to 昀椀le< kako bi odabrali naziv (npr „Dionica D8<) i mjesto 
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pohrane datoteke u koju će se spremi} rezulta} presjeka ova dva vektorska sloja. Za kraj 
kliknemo na Run. 

Za uočljiviji prikaz novoformiranog vektorskog linijskog sloja ponovno možemo promijeni} 
boju i debljinu sloja na način koji je već prethodno opisan. Također možemo isključi} kvačice 
nepotrebno vidljivih slojeva (npr poligona „Poligon D8< i „Cestovni promet<). 

 

 

Slika 3.17 De昀椀niranje parametara za rezanje slojeva 
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Slika 3.18 Uređivanje sloja <dionica D8= 

3.2. PRIMJENA QGIS MODULA ˝WIND EFFECT˝ 

U nastavku želimo iskoris}} QGIS simulacijsku ru}nu sa kojom se mogu odredi} utjecaju 
orogra昀椀je na intenzitet djelovanja vjetra. Rasterski sloj „EU_DEM_RH_HTRS96.}昀昀< predstavlja 
podlogu za provedbu simulacije, ali prethodno želimo de昀椀nira} samo onaj dio rasterskog sloja 
„EU_DEM_RH_HTRS96.}昀昀< na kojem se odvija relevantni dio razvoja vjetrovnog djelovanja. 
Dakle, prvo je potrebno kreira} novi vektorski poligonski sloj za narednu ekstrakciju 
relevantnog podpodručja rasterskog sloja „EU_DEM_RH_HTRS96.}昀昀<. Rubne točke tog 
poligona trebaju obuhva}} planinske lance koji se nalaze u zaobalju (vidi narednu sliku). 
Procedura kreiranja novog vektorskog poligonskog sloja je već prethodno objašnjena. Ovdje je 
za taj poligonski sloj dano ime „poligon D8 za EU_DEM.shp<. 

 

 

Slika 3.19 Kreiranje poligona za buduće rezanje („klipanje<) rastera 

Sada radimo klipanje rastera „EU_DEM_RH_HTRS96.}昀昀< sa prethodno kreiranim poligonom 
„poligon D8 za EU_DEM.shp<. 

Raster → Extrac琀椀on → Clip raster by mask layer 

 

Za „Input Layer< odabiremo raster „EU_DEM_RH_HTRS96.}昀昀<, a za „Mask layer< vektorski 
poligon „poligon D8 za EU_DEM.shp<. Pod „Advanced parameters< pri}skom na gumb pored 
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kućice „Clipped< otvara se mogućnost za izbor imena i mjesta pohrane novog „klipanog< 
rastera. U ovom primjer dano je ime „EU_DEM za model vjetra na D8.}f<.  

 

 

Slika 3.20 Rezanje („klipanje<) rastera poligonom 

Za bolju preglednost nakon ovog možemo isključi} kvačice pored „EU_DEM_RH_HTRS96.}昀昀< 
i promijeni} boje za novi raster „EU_DEM za model vjetra na D8.}f<. 

 

Sada u desnom prozoru „Processing toolbox< upišemo naredbu „Wind e昀昀ect<. Dvostrukim 
klikom na naredbu se otvara radni prozor za upis podataka. U kućicu „Eleva}on< se odabire 
prethodno kreirani raster visina za analizirano podpodručje „EU_DEM za model vjetra na 
D8.}f<, u kućicu „Constant wind direc}on< se upisuje vrijednost 22,50 a u kućicu „Wind 
direc}on units< se odabire „degree<. Ovime smo dali informaciju da je smjer djelovanja vjetra 
konstantan po cijelom području, odnosno da je smjer djelovanja vjetra prostorno homogen.  

Ak}viranjem gumba pored kućice „Wind e昀昀ect< otvara se prozor za izbor mjesta i imena 
datoteke (ovdje je dano ime „Wind e昀昀ect na D8.}昀昀<). Završavamo sa Run.  
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Slika 3.21 De昀椀niranje parametara i kreiranje novog rasterskog sloja „Wind e昀昀ect na D8< 

 

Dobiveni rezulta} u rasteru „Wind e昀昀ect na D8.}昀昀< prikazuju polje u kojem vrijednos} >1 
naznačuje pozicije lokalnog povećanja brzine vjetra a vrijednos} <1 naznačuje pozicije lokalnog 
smanjenja brzine vjetra.  Ponovno možemo promijeni} boje u prikazu rezultantnog rastera  
„Wind e昀昀ect na D8< na već prethodno objašnjeni način (naredna slika). 
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Slika 3.22 Dodavanje spektralnog izgleda „Wind e昀昀ect< sloju 

 

Za pregled rasterskih vrijednos} potrebno je instalira} „Plugin< pod nazivom „Serval<. 

 

 

Slika 3.23 Instaliranje dodatka („Plugin-a<) „Serval< 

U nastavku trebamo prethodno kreirani vektorski linijski sloj za analiziranu dionicu D8 „dionica 
D8.shp< pretvori} u vektorski točkas} sloj. Problem je u tome što linijski vektorski sloj „dionica 
D8.shp< ima vrlo veliki broj točaka loma na različi}m međusobnim udaljenos}ma uzduž linije, 
od nekoliko metara do nekoliko dese}na metara. Mi smo zainteresirani za formiranje 
vektorskog točkastog sloja uzduž trase dionice D8 sa jednolikom međusobnom udaljenos} 
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točaka (ver}sisa). To se može napravi} upisom naredbe „Points along geometry< u desni 
prozor „Processing Toolbox<.  

 

Dvostrukim klikom na naredbu se otvara radni prozor za upis podataka. U kućicu „Eleva}on< 
se odabire vektorski sloj „dionica D8.shp<, u kućicu „Distance< se upisuje vrijednost 25 (m) jer 
je to ujedno prostorna rezolucija rastera sa rezulta}ma „Wind e昀昀ect na D8.}昀昀<. Ak}viranjem 
gumba pored kućice „Interpolated points< otvara se prozor za izbor mjesta i imena datoteke 
(ovdje je dano ime „dionica D8 na 25m.shp<). Završavamo sa Run.  

 

 

Slika 3.24 Generiranje točaka na razmaku od 25 metara duž dionice 

Za kraj je još samo potrebno napravi} ekstrakciju podataka iz rastera „Wind e昀昀ect na D8.}昀昀< 
na mjestu točaka iz pretehodno kreiranog vektorskog točkastog sloja „dionica D8 na 25m.shp<. 
To se može napravi} upisom naredbe „Sample raster values< u desni prozor „Processing 
Toolbox<.  

 

Dvostrukim klikom na naredbu se otvara radni prozor za upis podataka. U kućicu „Input layer< 
se odabire točkas} vektorski sloj „dionica D8 na 25m.shp<, a u kućicu „Raster layer< se odabire 
„Wind e昀昀ect na D8.}昀昀<. Ak}viranjem gumba pored kućice „Sampled< otvara se prozor za izbor 
mjesta i imena datoteke (ovdje je dano ime „ekstrakcija WIND-EFFECT po tockama.shp<). 
Završavamo sa Run.  
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Slika 3.25 Ekstrakcija „Wind E昀昀ect< rastera na mjesto točaka iz sloja „dionica D8 na 25m<  

Kreirani točkas} vektorski sloj „ekstrakcija WIND-EFFECT po tockama.shp< potrebno je 
dodatno obradi} da se izbrišu nepotrebni atribu}-kolone u „A琀琀ribute table< (ostavi} samo 
kolonu sa vrijednos}ma Wind e昀昀ect), te da se dodaju kolone za X i Y koordinatu u HTRS95. 

Prvo se ak}vira ikona u gornjoj traci sučelja „A琀琀ribute table<, nakon toga se u novootvorenom 
prozoru ak}vira ikona „Toggle edi}ng mode< (olovka), te ikona „delete 昀椀eld<. Odabiru se kolone 
koje nisu potrebne, te se pri}sne OK. 

  
Slika 3.26 Brisanje nepotrebnih atributnih kolona sloju 
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Za kreiranje novih kolona odabra} ikonu „Open 昀椀eld calculator<. U kućicu „Output 昀椀eld name< 
upisa} „X<, za „Output 昀椀eld type< odabra} „Decimal number<, a u kućicu koja je u sredini 
prozora upisa} „$x<. Dvostrukim klikom na „$x< ista oznaka „$x< se pojavljuje i u lijevom 
prozoru. Nakon potvrde akcije sa OK dobivena je jedna nova kolona u kojoj se nalaze X 
koordinate točaka u HTRS95. Ista procedura se ponavlja i za Y koordinatu. Po završetku 
pri}snemo na ikonu olovke, te potvrđujemo željene promjene sa Yes.  

 

 

 

Slika 3.2 i Slika 3.28 Dodavanje novih X i Y koordinata u atributne kolone sloja 
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4. REZULTATI PROVEDENIH ANALIZA 

Nakon što su dobivene točke s pripadajućim koordinatama u prethodnom koraku,dalje 
se de昀椀niraju točke na kojima su vrijednos} ˝wind e昀昀ect˝ veće od najveće vrijednos} 
brzine vjetra na pozicijama točaka Balinskog vijadukta,te se iskazuju omjeri. 
 

 

                                 
Slika 4.1 Točke koje imaju brzinu vjetra manju   Slika 4.2 Točke koje imaju brzinu vjetra veću 

od referentne brzine (žuta boja)                           od referente brzine (crvena boja) 

 

U slučaju smjera vjetra od 22,5° veliki dio točaka na dionici S}nica – Prizna ne prelazi kri}čnu  
brzinu vjetra koja je izmjerena na Balinskom mostu. Broj točaka s većim brzinama od one na 
Balinskom mostu je 70 od 767 točaka što iznosi 9,13%dionice.  

Na segmen}ma južno od S}nice prema Prizni postoji veći broj točaka kojima je brzina vjetra 
veća od referentne .  

 

S}nica 

Prizna 

S}nica 

Prizna 
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Slika 4.3 Izdvojena dionica sa točkama                   Slika 4.4  Tumač nadmorskih visina 

brzine veće od referentne  
 

Na dionici ceste koja se nalazi u području s velikim visinskim razlikama, zabilježeni su uvje} koji 
uzrokuju pojačano djelovanje vjetra. Ovi uvje} rezultat su orografskih učinaka, gdje se zrak, pri 
prolasku preko brdovitog terena, uspinje i za}m pada, što dovodi do promjena u brzini i smjeru 
vjetra. Na nekim dionicama, koe昀椀cijen} brzine vjetra su veći od referentnih vrijednos}, što 
dodatno povećava rizik za vozače. Mjerenja su pokazala da brzina vjetra na }m segmen}ma 
dionice premašuje uobičajene granice, što zah}jeva posebnu pažnju pri upravljanju vozilima.  

 

Slika 4.5 3D prikaz dionice sa točkama brzine veće od brzine izmjerene na Balinskom mostu 

 

 

Prizna 
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Topografski uvje} na dionici S}nica - Prizna imaju značajnu ulogu u oblikovanju vjetrova. Ova 
dionica prolazi kroz brdovi} i planinski teren. Promjene u visini i nagibu tla mogu uzrokova} 
ubrzanje vjetra. Kada zrak prolazi kroz uske prolaze ili se penje uz padine, može se poveća} 
njegova brzina. Preporučuje se dodatna analiza i praćenje uvjeta vjetra, kako bi se osigurala 
sigurnost svih sudionika u prometu. Iako bi ugradnja vjetrobrana mogla poboljša} sigurnost na 
ovim rizičnim segmen}ma, treba uze} u obzir da je njihova instalacija skupa. Stoga je važno 
razmotri} alterna}vne mjere, kao što su redovita upozorenja za vozače, poboljšanje 
infrastrukture ili druga rješenja koja bi smanjila rizik od utjecaja jakog vjetra 
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5. ZAKLJUČAK 

U ovom radu provedena je analiza prostorne raspodjele brzine vjetra na dionici ceste između 
S}nice i Prizne temeljem modula „Wind e昀昀ect<, dostupnog u sklopu plavorme QGIS, te brzine 
i smjera vjetra iz numeričkog atmosferskog modela Aladin-Hr u razdoblju 1998.-2001. 

Primjena GIS modela ima mnoge prednos} kao što su preglednos} zahvaljujući visokoj rezoluciji, 
detaljna topografska podloga, jednostavnost, pristupačnost.Prate se mjereni jednosekundni udari 
vjetra na lokacijama Balinski vijadukt,pra} se i temeratura i stanje kolnika.  

Primjerice,za teretna i osobna vozila maksimalni dozvoljeni sekundni udari vjetra su 110 km/h pri 
uvje}ma suhog kolnika ,90 km/h  pri uvje}ma mokrog kolinka te 60 km/h pri uvje}ma zaleđenog 
kolnika.  

Rezulta} provedenih proračuna na spomenutoj dionici državne ceste D8  pokazali su da nije 
potrebno zatvaranje spomenute dionice budući da je broj točaka s većom brzinom od brzine na 
Balinskom mostu minimalan. Dionica S}nica – Prizna duga je 19km, a za proračune brzine uzduž 
analizirane cestovne dionice korištena je prostorna rezolucija podataka od 25m. Na cijelom 
potezu dionice samo 9,13% dionice ima brzine vjetra veće od referentne brzine na Balinskom 
mostu. Na segmen}ma južno od S}nice prema Prizni postoji veći broj točaka kojima je brzina vjetra 
veća od referentne, te točke nalaze se uz otvoreno more okružene Velebitom te bi bilo dobro 
napravi} dodatne analize i razmatranja za zaš}tu vozila u obliku burobrana ili neki slični oblici 
vjetrovne zaš}te da se ne bi zatvarala cijela dionica .Budući da situacije u kojima je promet zatvoren 
generiraju značajan društveni trošak,nemogućnost obavljanja poslova koji se provode tom 
dionicom,izgubljeno vrijeme te nega}van utjecaj na turizam. 
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